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Introduction
易灵思 provides a soft RISC-V SoC, called Opal, that you can implement in Trion® or
钛金系列 FPGAs. This user guide describes how to:
• Build RTL designs using the Opal RISC-V SoC using an example design targeting an
易灵思® development board, and how to extend the example for your own application.
• Set up the software development environment using an example project, create your own
software based on example projects, and use the API.
Important: 易灵思 will be obsoleting the Opal SoC in an upcoming Efinity software release and replacing
it with the Sapphire SoC. You cannot migrate automatically from the Opal SoC to the Sapphire SoC.
Therefore, 易灵思 recommends that you use the Sapphire SoC for all new designs. You can continue to
use the Opal SoC with the Efinity software v2021.2 and lower. However, the Opal SoC will not be
supported infuture Efinity releases.

This user guide describes how to use the Opal SoC that is provided with the Eﬁnity® v2020.2
or higher. Previous versions of the SoC were available as downloads in the Support Center.
Although the functionality of the SoC is essentially the same, the IP Manager allows you to
set parameters to customize the Opal SoC, and the resulting directory structure is diﬀerent.
Figure 1: Designing Hardware and Software for the Opal RISC-V SoC
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Create Hardware
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1. Windows build tools required on Windows platforms only.
Learn more: Refer to the Opal RISC-V SoC Data Sheet for detailed specifications on the SoC.

VexRiscv RISC-V Core
The Opal SoC is based on the VexRiscv core created by Charles Papon. The VexRiscv core
is a 32-bit CPU using the ISA RISCV32I with M and C extensions and has ﬁve pipeline stages
(fetch, decode, execute, memory, and writeback).
In the Opal SoC, the cacheless VexRiscv core supports an APB3 bus interface.
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The VexRiscv core won ﬁrst place in the RISC-V SoftCPU contest in 2018.(1)

Required Software
To write software for the Opal SoC, you need the following tools. The SDK is available as a
single download in the Support Center for Windows and Ubuntu operating systems.

Efinity® Software
易灵思® development environment for creating RTL designs targeting Trion® or 钛金系列
FPGAs. The software provides a complete RTL-to-bitstream ﬂow, simple, easy to use GUI
interface, and command-line scripting support.
Version: 2020.2 or higher

RISC-V SDK
Eclipse MCU—Open-source Java-based development environment that uses plug-ins to
extend and customize its functionality. The GNU MCU Eclipse plug-in lets you develop
applications for ARM and RISC-V cores.
Version: 2020-09 (4.17.0)
Disk space required: 433 MB (Windows), 433 MB (Linux)
xPack GNU RISC-V Embedded GCC—Open-source, prebuilt toolchain from the xPack
Project.
Version: 8.3.0-2.3
Disk space required: 1.53 GB (Windows), 1.5 GB (Linux)
OpenOCD Debugger—The open-source Open On-Chip Debugger (OpenOCD) software
includes conﬁguration ﬁles for many debug adapters, chips, and boards. Many versions of
OpenOCD are available. The 易灵思 RISC-V ﬂow requires a custom version of OpenOCD
that includes the VexRiscv 32-bit RISC-V processor.
Version: 20200421
Disk space required: 9.4 MB (Windows), 7.4 MB (Linux)
GNU MCU Eclipse Windows Build Tool (Windows Only)—This open-source Windowsspeciﬁc package helps to manage build projects and includes GNU make.
Version: 4.2.1-2-win32-x64
Disk space required: 4.99 MB

Java JRE
Open-source Java 64-bit runtime environment; required for Eclipse.
Version: 8 Update 241
https://www.java.com/en/download/manual.jsp (Java 8 official release)
https://developers.redhat.com/products/openjdk/download (OpenJDK 8 or 11)
http://jdk.java.net/16/ (OpenJDK 16)

(1)

https://www.businesswire.com/news/home/20181206005747/en/RISC-V-SoftCPU-Contest-Winners-DemonstrateCutting-Edge-RISC-V
www.elitestek.com
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Required Hardware
•
•
•
•

Trion® T20 BGA256 Development Board or 钛金系列 Ti60 F225 Development Board
Micro-USB cable
Computer or laptop
(Optional) USB to UART converter module for the
Trion® T20 BGA256 Development Board(2)
• (Optional) FTDI chip cable, C232HM-DDHSL-0, if you want to use the OpenOCD
debugger and Eﬁnity® Debugger simultaneously
Note: Some of the software examples provided with the SoC use a UART terminal to display messages.
See Set Up a USB-to-UART Module (Trion) on page 40 and Using the On-board UART (钛金系列) on
page 39 for more information.

(2)

The 钛金系列 Ti60 F225 Development Board had an on-board USB-to-UART converter and does not require a separate
module.
www.elitestek.com
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Chapter 1

Install Software and SoC
Contents:
•
•
•

Install the Efinity Software
Install the RISC-V SDK
Install the Java JRE

Install the Efinity® Software
If you have not already done so, download the Eﬁnity® software from the Support Center
and install it. For installation instructions, refer to the Eﬁnity Software Installation User
Guide.
Warning: Do not use spaces or non-English characters in the Efinity path.

Install the RISC-V SDK
To install the SDK:
1. Download the ﬁle riscv_sdk_windows-v<version>.zip or riscv_sdk_ubuntuv<version>.zip from the Support Center.

2. Create a directory for the SDK, such as c:\riscv-sdk (Windows) or home/my_name/
riscv-sdk (Linux).
3. Unzip the ﬁle into the directory you created. The complete SDK is distributed as
compressed ﬁles. You do not need to run an installer.
Windows directory structure:
• SDK_Windows
— eclipse—Eclipse application.
— GNU MCU Eclipse—Windows build tools.
— openocd—OpenOCD debugger.
— riscv-xpack-toolchain_8.3.0-1.1_windows—GCC compiler.
— run_eclipse.bat—Batch ﬁle that sets variables and launches Eclipse.
— setup.bat—Batch ﬁle to set variables for running OpenOCD on the command line to
ﬂash the binary.
Ubuntu directory structure:
• SDK_Ubuntu<version>
— eclipse—Eclipse application.
— openocd—OpenOCD debugger.
— riscv-xpack-toolchain_8.3.0-1.1_linux—GCC compiler.
— run_eclipse.sh—Shell ﬁle that sets variables and launches Eclipse.
— setup.sh—Shell ﬁle to set variables for running OpenOCD on the command line to
ﬂash the binary.
www.elitestek.com
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Install the Java JRE
To install the JRE:
1. Download the 64-bit version of the JRE or JDK for your operating system from
https://www.java.com/en/download/manual.jsp (Java 8 official release)
https://developers.redhat.com/products/openjdk/download (OpenJDK 8 or 11)
http://jdk.java.net/16/ (OpenJDK 16)
2. Follow the installation instructions on the web site to install the JRE.

Note: You need a 64-bit version of the Java JRE. If you use a 32-bit version, when you try to launch Eclipse
you will get an error that Java quit with exit code 13.

www.elitestek.com
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Chapter 2

IP Manager
Contents:
•
•

Customizing the Opal SoC
Modify the Bootloader

Starting with v2020.2, the Opal SoC is delivered with the Eﬁnity® software; you do not need
to download and install it separately. You use the IP Manager to conﬁgure the Opal SoC and
add it to your project.
The Eﬁnity® IP Manager is an interactive wizard that helps you customize and generate
易灵思® IP cores. The IP Manager performs validation checks on the parameters you set to
ensure that your selections are valid. When you generate the IP core, you can optionally
generate an example design targeting an 易灵思 development board and/or a testbench. This
wizard is helpful in situations in which you use several IP cores, multiple instances of an IP
core with diﬀerent parameters, or the same IP core for diﬀerent projects.
The IP Manager consists of:
• IP Catalog—Provides a catalog of IP cores you can select. Open the IP Catalog using the
toolbar button or using Tools > Open IP Catalog.
• IP Conﬁguration—Wizard to customize IP core parameters, select IP core deliverables,
review the IP core settings, and generate the custom variation.
• IP Editor—Helps you manage IP, add IP, and import IP into your project.

Generating an Opal SoC with the IP Manager
The following steps explain how to customize an IP core with the IP Conﬁguration wizard.
1. Open the IP Catalog.
2. Choose an IP core and click Next. The IP Conﬁguration wizard opens.
3. Enter the module name in the Module Name box.
Note: You cannot generate the core without a module name.

4. Customize the IP core using the options shown in the wizard. For detailed information
on the options, refer to the IP core's user guide or on-line help.
5. (Optional) In the Deliverables tab, specify whether to generate an IP core example
design targeting an易灵思® development board and/or testbench. For SoCs, you can
also optionally generate embedded software example code. These options are turned on
by default.
6. (Optional) In the Summary tab, review your selections.
7. Click Generate to generate the IP core and other selected deliverables.
8. In the Review conﬁguration generation dialog box, click Generate. The Console in the
Summary tab shows the generation status.
Note: You can disable the Review configuration generation dialog box by turning
off the Show Confirmation Box option in the wizard.

9. When generation ﬁnishes, the wizard displays the Generation Success dialog box. Click
OK to close the wizard.
The wizard adds the IP to your project and displays it under IP in the Project pane.

www.elitestek.com
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Generated RTL Files
The IP Manager generates these ﬁles and directories:
• <module name>_define.vh—Contains the customized parameters.
• <module name>_tmpl.v—Verilog HDL instantiation template.
• <module name>_tmpl.vhd—VHDL instantiation template.
• <module name>.v—IP source code.
• settings.json—Conﬁguration ﬁle.
• <kit name>_devkit—Has generated RTL, example design, and Eﬁnity® project targeting
a speciﬁc development board.
• Testbench—Contains generated RTL and testbench ﬁles.
Note: Refer to the IP Manager chapter of the Efinity Software User Guide for more information about the
Efinity IP Manager.

Generated Software Code
If you choose to output embedded software, the IP Manager saves it into the <project>/
embedded_sw/<SoC module> directory.
• bsp—Board speciﬁc package.
• config—Has the Eclipse project settings ﬁle and OpenOCD debug conﬁguration settings
ﬁles for Windows.
• config_linux—Has the Eclipse project settings ﬁle and OpenOCD debug conﬁguration
settings ﬁles for Linux.
• software—Software examples.
• tool—Helper scripts.
• cpu0.yaml—CPU ﬁle for debugging.

Instantiating the SoC
The IP Manager creates these template ﬁles in the <project>/ip/<module name> directory:
• <module name>.v_tmpl.v is the Verilog HDL module.
• <module name>.v_tmpl.vhd is the VHDL component declaration and instantiation
template.
To use the IP, copy and paste the code from the template ﬁle into your design and update the
signal names to instantiate the IP.
Important: When you generate the IP, the software automatically adds the module file (<module
name>.v) to your project and lists it in the IP folder in the Project pane. Do not add the <module name>.v
file manually (for example, by adding it using the Project Editor); otherwise the Efinity® software will issue
errors during compilation.

Do not manually add
IP to the Design folder

IP Manager adds generated
IP to the IP folder (and
your project) automatically

www.elitestek.com
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Customizing the Opal SoC
The core has parameters so you can customize its function. You set the parameters in the
General tab of the core's IP Conﬁguration window.
Table 1: Opal SoC Parameters
Parameter

Options

SoC Operating
Frequency (Hz)

20 - 300

Description
Enter the frequency in MHz.

For the example design, if you change the frequency, you need
to manually change the PLL setting and SDC timing constraint for
io_systemClk to match the new frequency.

For T8 FPGAs, the SoC cannot operate higher than about 25 MHz.
If you choose a frequency higher than that, the Efinity® software
will fail to close timing and the design will interrmittently hang in
hardware.
Default: 80
SoC On-Chip Ram
Size
Enable Soft JTAG
TAP

4KB, 8KB, 16KB,
The size of the on-chip block RAM for the SoC.
32KB, 64KB, 128KB, Default: 4KB
256KB, 512KB
True, False

Choose whether you want to include a soft debug TAP for
debugging.

False: Default. The SoC uses the JTAG User TAP interface block to
communicate with the OpenOCD debugger.
True: The SoC has a soft JTAG interface to communicate with the
OpenOCD debugger. You need to use this setting for T8 BGA49
or BGA81 designs or if you want to use the soft JTAG interface
instead of the JTAG User TAP. After enabling the soft JTAG TAP,
you need to manually assign the pins with the Interface Designer.

Important: When running the SoC at high frequencies, 易灵思 recommends that you use the
TIMING_1 place and route optimization. To set this option:
1. Open the Project Editor.

2. Click the Place and Route tab.

3. Double-click the Value cell for --optimization_level.
4. Choose TIMING_1.

5. Click OK and then compile.

www.elitestek.com
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Modify the Bootloader
When you generate the Opal SoC, the IP Manager creates a pre-built bootloader .bin to
target the on-chip RAM size you selected. If you want to create a custom bootloader, use the
following instructions.
Note: You need the embedded software example code to make these changes; if you have not already
done so, generate it.

Modify the Bootloader Software
First you need to modify the bootloader code:
1. Open the bootloaderConfig.h ﬁle in the embedded_sw/<SoC module>/bsp/efinix/
EfxOpalSoc/app directory.
2. Change the #define USER_SOFTWARE_SIZE parameter for the new on-chip RAM
size and save.
3. In Eclipse, create a new project from the makeﬁle in the embedded_sw/<SoC
module>/software/standalone/bootloader directory and compile it.

Re-Generate the Memory Initialization Files
Next, you need to re-generate the memory initialization ﬁles using the binGen.py helper
script. You ﬁnd this script in the <project>/embedded_sw/<SoC module>/tool
directory. Use the command:
python binGen.py -b bootloader.bin -c opalsoc -t <TAP> -s <RAM size>

where:
• <TAP> is hard or soft, depending on whether you are using the soft JTAG TAP.
• <RAM size> is the on-chip RAM size you want to use.
This command generates the new memory initialization ﬁles. Copy these ﬁles into the same
directory as your project .xml ﬁle, replacing the existing ﬁles.
Compile your design.

www.elitestek.com
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Chapter 3

Program the Board with the Opal RTL Design
Contents:
•
•
•

About the Example Design
Installing USB Drivers
Program the Development Board

Before working with software code, 易灵思 recommends that you program your board
with an RTL design that instantiates the Opal SoC. When you generate the Opal SoC with
the IP Manager, you can optionally generate an example Eﬁnity® project and bitstream ﬁle
to get you started quickly.

About the Example Design
This example targets 易灵思 development boards for Trion or 钛金系列 FPGAs. You
can access the RTL design ﬁles in the <product>_devkit directory. This example
softwareblinks an LED and displays messages on a UART terminal.
The Opal SoC is conﬁgured for:
• 80 MHz frequency
• 4096 RAM size
• Soft TAP is false
Figure 2: Example Design Block Diagram
Ti60 F225 or T20 F256 FPGA
Opal SoC
apb3LED
FTDI JTAG TAP
or GPIO Pins
pll_refclk

Control
Logic

APB3
Slave

JTAG

Debug

RISC-V
CPU

GPIO
UART

PLL
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Table 2: 钛金系列 Example Design Implementation
Compiled with --optimization_level set to TIMING_1.
FPGA

Logic/
Adders

FlipFlops

Memory
Blocks

DSP48
Blocks

fMAX (MHz)

Language

Efinity
Version

Ti60
F225 C3

4,500

2,394

14

4

165.8

Verilog HDL

2021.2

Table 3: Trion Example Design Implementation
Compiled with --optimization_level set to TIMING_1.
FPGA

Logic Utilization
(LUTs)

Memory Blocks

fMAX (MHz)

Language

Efinity Version

T20 BGA256 C4

5,411

18

86.03

Verilog HDL

2021.2

www.elitestek.com
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Installing USB Drivers
易灵思 development boards have FTDI chips (FT232H, FT2232H, or FT4232H) to
communicate with the USB port and other interfaces such as SPI, JTAG, or UART. These
chips have separate channels for each interface. If you install a driver for each interface, each
interface appears as a unique FTDI device. If you install a composite driver, all of the separate
interfaces appear as a single composite device.
• Trion® T20 BGA256 Development Board—Install a composite driver for this board.
• 钛金系列 Ti60 F225 Development Board—Install separate drivers for interfaces 0 and 1.
When working with OpenOCD on Windows, you need to install the libusbK driver as
described in the following sections.
Note: If you already installed the libusb-win32 driver and want to use OpenOCD, uninstall libusb-win32
and install libusbK instead.

Installing Drivers on Windows
(钛金系列 Ti60 F225 Development Board)
On Windows, you use software from Zadig to install drivers (zadig.akeo.ie). In the Zadig
software, the interface names end with (Interface N), where N is the channel number.
To install the interface drivers in Windows:
1. Connect the FTDI USB (J12) on the board to your computer with a USB type-C cable.
2. Download the Zadig software from zadig.akeo.ie. (You do not need to install it; simply
run the downloaded executable.)
3. Run the Zadig software.
Note: To ensure that the USB driver is persistent across user sessions, run the
Zadig software as administrator.

4. Choose Options > List All Devices.
5. Repeat the following steps for each interface. The interface names end with (Interface N),
where N is the channel number.
• Select libusb-win32 or libusbK in the Driver drop-down list. (Do not choose
WinUSB.)
• Click Replace Driver.
6. Close the Zadig software.
Important: Install drivers for interfaces 0 and 1 only. You do not need to install drivers for interfaces 2
and 3 because when you connect the 钛金系列 Ti60 F225 Development Board to your computer,
Windows automatically installs a driver for them.

www.elitestek.com
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Installing Drivers on Windows
(Trion® T20 BGA256 Development Board)
You use the Zadig software to install the driver, but instead of installing for separate
interfaces, you install a composite driver.
1. Connect the board to your computer with the appropriate cable and power it up.
2. Download the Zadig software from zadig.akeo.ie. (You do not need to install it; simply
run the downloaded executable.)
3. Run the Zadig software.
Note: To ensure that the USB driver is persistent across user sessions, run the
Zadig software as administrator.

4.
5.
6.
7.
8.
9.

Choose Options > List All Devices.
Turn oﬀ Options > Ignore Hubs or Composite Parents.
Select the Trion® T20 BGA256 Development Kit.
Choose libusbK in the Driver drop-down list.
Click Replace Driver.
Close the Zadig software.

Installing Drivers on Linux (All Kits)
The following instructions explain how to install a USB driver for Linux operating systems.
1. Disconnect your board from your computer.
2. In a terminal, use these commands:
> sudo <installation directory>/bin/install_usb_driver.sh
> sudo udevadm control --reload-rules

Note: If your board was connected to your computer before you executed these
commands, you need to disconnect and re-connect it.

www.elitestek.com
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Program the Development Board
When you generate the Opal SoC in the IP Manager, you can optionally generate an example
design targeting an 易灵思 development board. Example designs include a bitstream ﬁle,
soc_opalSoc.hex, so you can get started quickly without having to compile the design.
Table 4: Available Example Designs
Board

Location

Trion® T20 BGA256 Development Board

T20F256_devkit

钛金系列 Ti60 F225 Development Board

Ti60F225_devkit

Download the .hex ﬁle to the board using these steps:
1. Connect the board to your computer using a USB cable.
2. Use the Eﬁnity® Programmer and SPI active programming mode to download the
bitstream ﬁle to the board.
Note: Although you can use any programming mode, 易灵思 recommends using
SPI active, which programs the design into the flash device on the board. That way,
if you power cycle the board the FPGA configures with the SoC design.
Learn more: Instructions on how to use the Efinity software and board documentation are available in the
Support Center.

www.elitestek.com
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Chapter 4

Simulate
The Opal SoC has a testbench so you can simulate applications in the ModelSim simulator.
The simulation ﬁles are located in the Testbench directory. To simulate:
1. Open a terminal (Linux) or Command Prompt (Windows).
2. Change to your SoC module's Testbench directory.
3. Set up the Eﬁnity environment:
• Linux: source /<path to Efinity>/bin/setup.sh
• Windows: source c:\<path to Efinity>\bin\setup.bat
4. To simulate with the default software application, use the command python3 run.py.
A successful simulation returns the following messages:
#
#
#
#
#
#
#
#
#
#
#
#
#

0
0
0
50115
50115
50265
50265
50265
132665
132665
232665
232665
232665

----------------------------------------[EFX_INFO]: Start executing blinkAndEcho TEST
--------------------------------------------------------------------------------[EFX_INFO]: Receiving uart data from soc
----------------------------------------[EFX_INFO]: GPIO TEST PASSED
----------------------------------------[EFX_INFO]: UART TEST PASSED
--------------------------------------------------------------------------------[EFX_INFO]: blinkAndEcho TEST PASSED
-----------------------------------------

5. (Optional) If you want to simulate with your own software application (you need to
develop your own sequence for your application):
• Copy your application binary into the Testbench directory.
• Simulate with the command
python3 run.py -b <path to app><application>.bin
The bootloader retrieves data from the SPI ﬂash memory upon boot-up. For simulation, the
retrieval time can be long. Therefore, to speed up simulation, the testbench toggles a reset
after 10 ms. When simulating your own application, adjust the reset so that it does not occur
until the SPI ﬂash device has ﬁnished sending your application data to the SoC.
Note: By default, the memory initialization files contain a bootloader application that fetches the data
size corresponding to the on-chip RAM size you selected in the IP Manager. If you want build a custom
bootloader, refer to Modify the Bootloader on page 12.
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Chapter 5

Launch Eclipse
Contents:
•

Set Global Environment Variables

The RISC-V SDK includes the run_eclipse.bat ﬁle (Windows) or run_eclipse.sh ﬁle
(Linux) that adds executables to your path, sets up envonment variables for the Opal BSP,
and launches Eclipse. Always use this executable to launch Eclipse; do not launch Eclipse
directly.
When you ﬁrst start working with the Opal SoC, you need to conﬁgure your Eclipse
workspace and environment. Setting up a global development environment for your
workspace means you can store all of your Opal software code in the same place and you can
set global environment variables that apply to all software projects in your workspace.
You should use a unique workspace for your Opal SoC projects. 易灵思 recommends using
the embedded_sw/<SoC module> directory as the workspace directory.
Note: With IP Manager, you can generate multiple SoCs with different options. Using the
embedded_sw/<SoC module> directory as your workspace means that you can explore more than one
SoC by simply switching workspaces.

Follow these steps to launch Eclipse and set up your workspace:
1. Launch Eclipse using the run_eclipse.bat ﬁle (Windows) or run_eclipse.sh ﬁle.
2. The launch script prompts you to select your SoC. Type 4 for Opal and press enter.
3. If this is the ﬁrst time you are running Eclipse, create a new workspace that points to
the embedded_sw/<SoC module> directory. Otherwise, choose File > Switch
Workspace > Other to choose an existing workspace directory and click Launch.

Set Global Environment Variables
OpenOCD uses two environment variables, DEBUG and DEBUG_OG. It is simplest to set
them as global environment variables for all projects in your workspace. Then, you can
adjust them as needed for individual projects.
Choose Window > Preferences to open the Preferences window and perform the following
steps.
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1. In the left navigation menu, expand C/C++ > Build.
2. Click C/C++ > Build > Environment.
3. Click Add and add the following environment variables:
Variable
DEBUG

Value
no

Description
Enables or disables debug mode.
no: Debugging is turned off
yes: Debugging is enabled

DEBUG_OG no

Enables or disables optimization during debugging.
Use an uppercase letter O not a zero.

4. Click Apply and Close.
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Chapter 6

Create and Build a Software Project
Contents:
•
•
•
•

Create a New Project
Import Project Settings (Optional)
Enable Debugging
Build

After you set up your Eclipse workspace, you are ready to create a new project and build
it. These instructions walk you through the process using the EfxApb3Example example
project from the software directory.

Create a New Project
In this step you create a new project from the EfxApb3Example code example.
1. Launch Eclipse.
2. Select the Opal workspace if it is not open by default.
3. Make sure you are in the C/C++ perspective.
Import the EfxApb3Example example:
4.
5.
6.
7.
8.

Choose File > New > Makeﬁle Project with Existing Code.
Click Browse next to Existing Code Location.
Browse to the software/standalone/EfxApb3Example directory and click Select Folder.
Select <none> in the Toolchain for Indexer Settings box.
Click Finish.

Import Project Settings (Optional)
易灵思 provides a C/C++ project settings ﬁle that deﬁnes the include paths and symbols for
the C code. Importing these settings into your project lets you explore and jump through the
code easily.
Note: You are not required to import the project settings to build. These settings simply make it easier for
you to write and debug code.

To import the settings:
1.
2.
3.
4.
5.
6.

Choose File > Import to open the Import wizard.
Expand C/C++.
Choose C/C++ > C/C++ Project Settings.
Click Next.
Click Browse next to the Settings ﬁle box.
Browse to one of the following ﬁles and click Open:

www.elitestek.com

21

Opal RISC-V SoC Hardware and Software User Guide

Option
Windows
Linux

Description
embedded_sw\<SoC module>\config\project_settings_opal.xml
embedded_sw/<SoC
module>/config_linux/project_settings_opal_linux.xml

7. In the Select Project box, select the project name(s) for which you want to import the
settings.
8. Click Finish.

Eclipse creates a new folder in your project named Includes, which contains all of the ﬁles
the project uses.
After you import the settings, clean your project (Project > Clean) and then build (Project
> Build Project). The build process indexes all of the ﬁles so they are linked in your project.

Enable Debugging
When you set up your workspace, you deﬁned an environment variable for debugging with a
default value of no.
• To run the program for normal operation, keep DEBUG set to no.
• To debug with the OpenOCD debugger, set DEBUG to yes.
In debug mode, the program suspends operation after loading so that you can set breakpoints
or perform debug tasks.
To change the debug settings for your project, right-click the project name
EfxApb3Example in the Project Explorer and choose Properties from the pop-up menu.
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1.
2.
3.
4.
5.
6.
7.

Expand C/C++ Build.
Click C/C++ Build > Environment.
Click the Debug variable.
Click Edit.
Change the Value to yes.
Click OK.
Click Apply and Close.

Important: When you change the debug value for a project you previously built, you must clean the
project (Project > Clean) before building again. Otherwise, Eclipse gives a message in the Console that
there is Nothing to be done for 'all'

Build
Choose Project > Build Project or click the Build Project toolbar button.
The makefile builds the project and generates these ﬁles in the build directory:
• EfxApb3Example.asm—Assembly language ﬁle for the ﬁrmware.
• EfxApb3Example.bin—Download this ﬁle to the ﬂash device on your board using
OpenOCD. When you turn the board on, the SoC loads the application into the RISC-V
processor and executes it.
• EfxApb3Example.elf—Use this ﬁle when debugging with the OpenOCD debugger.
• EfxApb3Example.hex—Hex ﬁle for the ﬁrmware. (Do not use it to program the
FPGA.)
• EfxApb3Example.map—Contains the SoC address map.
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Chapter 7

Debug with the OpenOCD Debugger
Contents:
•
•

Import the Debug Configuration
Debug

With the development board programmed and the software built, you are ready to
conﬁgure the OpenOCD debugger and perform debugging. These instructions use the
EfxApb3Example example to explain the steps required.
Important: If you want to use the OpenOCD Debugger at the same time as the Efinity® Debugger, you
cannot use the same USB connection to the board because they conflict causing one of the applications to
crash. Refer to Efinity Debugger Crashes when using OpenOCD on page 47 for information on using
two USB cables to operate both debuggers simultaneously.

Import the Debug Configuration
To simplify the debugging steps, the Opal SoC includes debug conﬁgurations that you
import. There are several conﬁguration ﬁles, depending on which board you use.
Table 5: Debug Configurations
Debug
Configuration

Use for

default

Debugging software on Trion® development boards.

default_ti

Debugging software on 钛金系列 development boards.

default_softTap

Debugging software on Trion or 钛金系列 development boards with the soft JTAG
TAP interface. For example, you would need to use the soft TAP if you want to use the
OpenOCD debugger and the Efinity® Debugger at the same time. (See Using a Soft JTAG
Core for Example Designs on page 42.)

To import a debug conﬁguration and use it to launch a debug session:
1. Connect your board to your computer using a JTAG cable. If you are using an 易灵思
development board, you can use a USB cable instead.
2. Launch Eclipse by running the run_eclipse.bat ﬁle (Windows) or run_eclipse.sh
(Linux).
3. Select a workspace (if you have not set one as a default).
4. Open the EfxApb3Example project or select it under C/C++ Projects.
5. Right-click the EfxApb3Example project name and choose Import.
6. In the Import dialog box, choose Run/Debug > Launch Conﬁgurations.
7. Click Next. The Import Launch Conﬁgurations dialog box opens.
8. Browse to the following directory and click OK:
Option
Windows

Description
embedded_sw\<SoC module>\config
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Option
Linux

Description
embedded_sw/<SoC module>/config_linux

9. Check the box next to conﬁg (Windows) or conﬁg_linux (Linux).
10. Click Finish.
11. Right-click the EfxApb3Example project name and choose Debug As > Debug
Conﬁgurations.
12. Choose GDB OpenOCD Debugging > default (Trion FPGAs) or default_ti (钛金系
列 FPGAs).
13. Enter EfxApb3Example in the Project box.
14. Enter build\EfxApb3Example.elf in the C/C++ Application box.
15. Windows only: you need to change the path to the cpu0.yaml ﬁle:
a. Click the Debugger tab.
b. In the Conﬁg options box, change ${workspace_loc} to the full path to the
<SoC module> directory.
Note: For the cpu0.yaml path, make sure to use \\ as the directory separator
because the first slash escapes the second one. For example, use:

c:\\Efinity\\2020.2\\project\\<project name>\\embedded_sw\\<SoC module>
\\cpu0.yaml

16. Click Debug.
Note: If Eclipse prompts you to switch to the Debug Perspective, click Switch.

Debug
After you click Debug in the Debug Conﬁguration window, the OpenOCD server starts,
connects to the target, starts the gdb client, downloads the application, and starts the
debugging session. Messages and a list of VexRiscv registers display in the Console. The
main.c ﬁle opens so you can debug each step.
1. Click the Resume button or press F8 to resume code operation. All of the LEDs on the
board blink continuously in unison.
2. Click Step Over (F6) to do a single step over one source instruction.
3. Click Step Into (F5) to do a single step into the next function called.
4. Click Step Return (F7) to do a single step out of the current function.
5. Double-click in the bar to the left of the source code to set a breakpoint. Double-click a
breakpoint to remove it.
6. Click the Registers tab to inspect the processor's registers.
7. Click the Memory tab to inspect the memory contents.
8. Click the Suspend button to stop the code operation.
9. When you ﬁnish debugging, click Terminate to disconnect the OpenOCD debugger.
The EfxApb3Example example blinks the LEDs and prints messages on a UART terminal.
Refer to Using a UART Module on page 39 for steps on setting it up.
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Figure 3: Perform Debugging

Learn more: For more information on debugging with Eclipse, refer to Running and debugging projects
in the Eclipse documentation.
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Chapter 8

Create Your Own RTL Design
Contents:
•
•
•
•
•

Target another FPGA
Update the FTDI Driver for another 易灵思 Board
Target Your Own Board
Create a Custom APB3 Peripheral
Remove Unused Peripherals from the RTL Design

After you have explored the Opal SoC using the included example Eﬁnity® project, you can
use these tips to modify the design for your own use.
Note: 易灵思 recommends that you use the provided example design project as a starting point instead
of creating a new project.

Target another FPGA
To change the design to target a diﬀerent FPGA:
1. Edit the project to change the FPGA, package, and speed grade.
2. Update the interface design.
a. Open the Interface Designer. The software prompts you that a device change was
detected. Click Update Design. The Interface Designer opens and shows invalid
assignments in the Message Viewer.
b. Open the Resource Assigner.
c. Click the instance name in the Message Viewer. The software jumps to that
assignment in the Resource Assigner. Pick a new resource and press enter.
d. Continue re-assigning pins until all assignments are valid.
e. Generate a constraint ﬁle and close the Interface Designer.
3. Compile your modiﬁed design.

Update the FTDI Driver for another 易灵思
Board
The Opal SoC BSP includes FTDI conﬁguration ﬁles that specify the FTDI device VID and
PID and board description for 易灵思 development boards. You can update the driver(s) to
point to a diﬀerent 易灵思 development board.
Table 6: Provided FTDI Configuration Files
File

Use for

ftdi.cfg

Trion® T20 BGA256 Development Board

ftdi_ti.cfg

钛金系列 Ti60 F225 Development Board
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To target a diﬀerent 易灵思 development board, follow these steps with the development
board attached to the computer:
1. Open the Eﬁnity® Programmer.
2. Click the Refresh USB Targets button to display the board name in the USB Target
drop-down list.
3. Make note of the board name.
4. In a text editor, open the ftdi.cfg or ftdi_ti.cfg ﬁle in the embedded_sw/<SoC
module>/bsp/efinix/EfxOpalSoC/openocd directory.
5. Change the ftdi_device_desc setting to match the board name. For example, use
this code to change the name from Trion T20 Development Board to Trion T20 MIPI
Development Board:
interface ftdi
ftdi_device_desc "Trion T20 MIPI Development Board"
#ftdi_device_desc "Trion T20 Development Board"
ftdi_vid_pid 0x0403 0x6010

6. Save the ﬁle.
7. Debug as usual in OpenOCD.
Note: All 易灵思 development boards have the same VID and PID; therefore, you only need to change
the board description.

Target Your Own Board
For your own board, you generally use an FTDI cable or another JTAG cable or module.
You can also use an FTDI chip on your board.

Using the FTDI C232HM-DDHSL-0 JTAG cable
The Opal SoC also includes a conﬁguration ﬁle for the FTDI C232HM-DDHSL-0 JTAG
cable (c232hm_ddhsl_0.cfg), which bridges between your computer's USB connector
and the JTAG signals on the FPGA. If you use this cable to connect your board to your
computer, you can simply use this conﬁguration ﬁle instead of ftdi.cfg or ftdi_ti.cfg
Note: Refer to Connect the FTDI Cable on page 44 for instructions on using the cable.

Using another JTAG Cable or Module
Generally, when debugging your own board you use a JTAG cable to connect your
computer and the board. Therefore, you need to use the OpenOCD driver for that cable
when debugging. OpenOCD includes a number of conﬁguration ﬁles for standard hardware
products. These ﬁles are located in the following directory:
openocd/build-win64/share/openocd/scripts/interface (Windows)
openocd/build-x86_64/share/openocd/scripts/interface (Linux)
You can also write your own conﬁguration ﬁle if desired.
Follow these instructions when debugging with your own board:
1. Connect your JTAG cable to the board and to your computer.
2. Copy the OpenOCD conﬁguration ﬁle for your cable to the bsp/efinix/EfxOpalSoc/
openocd directory.
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3. Follow the instructions for debugging, except target your conﬁguration ﬁle instead of the
ftdi.cfg (Trion) or ftdi_ti.cfg (钛金系列) ﬁle.
-f <path>/bsp/efinix/EfxOpalSoc/openocd/<my cable>.cfg

Create a Custom APB3 Peripheral
When you generate an example design for the Opal SoC, the IP Manager creates an APB3
peripheral and software code that you can use as a template to create your own peripheral.
This simple example shows how to implement an APB3 slave wrapper.
• Refer to apb3_slave.v in the <product>_devkit directory for the RTL design.
• Refer to main.c in the embedded_sw/<SoC module>/software/standalone/
EfxApb3Example/src directory for the C code.

Remove Unused Peripherals from the RTL
Design
The Opal SoC includes a variety of peripherals. if you do not want to use a peripheral,
simply remove the signal name from within the parentheses () in the OpalSoc OpalSoc_inst
deﬁnition in the top-level Verilog HDL ﬁle. For example, the SoC instantiation has these
signals:
.system_i2c_0_io_sda_write
.system_i2c_0_io_sda_read
.system_i2c_0_io_scl_write
.system_i2c_0_io_scl_read

(system_i2c_0_io_sda_write),
(system_i2c_0_io_sda_read),
(system_i2c_0_io_scl_write),
(system_i2c_0_io_scl_read),

To disable I2C 0, remove the signal name in () as shown below:
.system_i2c_0_io_sda_write
.system_i2c_0_io_sda_read
.system_i2c_0_io_scl_write
.system_i2c_0_io_scl_read

(),
(),
(),
(),
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Chapter 9

Create Your Own Software
Contents:
•
•
•
•

Deploying an Application Binary
About the Board Specific Package
Address Map
Example Software

Now that you have explored the methodology for designing with the Opal SoC, you can
develop your own software applications.
Note: The Opal SoC does not currently support floating point calculations, such as sine and cosine.

Deploying an Application Binary
During normal operation, the user binary application ﬁle (.bin) is stored in a SPI ﬂash device.
When the FPGA powers up, the Opal SoC copies your binary application ﬁle from the SPI
ﬂash device to the on-chip memory, and then begins execution.
For debugging, you can load the user binary (.elf) directly into the Opal SoC using the
OpenOCD Debugger. After loading, the binary executes immediately.
Note: The settings in the linker prevent user access to the on-chip RAM address. This setting allows the
embedded bootloader to work properly during a system reset after the user binary is executed but the
FPGA is not reconfigured.

Boot from a Flash Device
When the FPGA boots up, the Opal SoC copies your binary application ﬁle from a SPI ﬂash
device to the on-chip memory, and then begins execution. The SPI ﬂash binary address starts
at 0x0038_0000.
For the Xyloni Development Board, the address starts at 0x000E_0000.
To boot from a SPI ﬂash device:
1. Power up your board. The FPGA loads the conﬁguration image from the on-board ﬂash
device.
2. When conﬁguration completes, the bootloader begins cloning a 4 KByte user binary ﬁle
from the ﬂash device at physical address 0x0038_0000 to the on-chip memory.
Note: It takes ~10 ms to clone a 4 KByte user binary (this is the default size).

3. The Opal SoC executes the user binary.
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Boot from the OpenOCD Debugger
To boot from the OpenOCD debugger:
1. Power up your board. The FPGA loads the conﬁguration image from the on-board ﬂash
device.
2. Launch Eclipse and set up the debug environment for your project.
3. When you click Debug, the debugger sends a soft reset to the SoC, and then writes the
user binary ﬁle to logical address 0xF900_0000, which is the starting address of the on-chip
memory.
4. The Opal SoC jumps to logical address 0xF900_0000 to execute the user binary.
5. The user binary is suspended on boot up. Click the Resume button to start the program.
Note: Refer to Debug with the OpenOCD Debugger on page 24 for complete instructions.

Copy a User Binary to Flash (Efinity Programmer)
To boot from a ﬂash device, you need to copy the application binary to the ﬂash. If you want
to store the binary in the same ﬂash device that holds the FPGA bitstream, you can simply
combine the two ﬁles and download the combined ﬁle to the ﬂash device with the Eﬁnity
Programmer.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Open the Eﬁnity Programmer.
Click the Combine Multiple Image Files button.
Choose Mode > Generic Image Combination.
Enter a name for the combined ﬁle in Output File.
Click the Add Image button. The Open Image File dialog box opens.
Browse to the bitstream ﬁle, select it, and click Open.
Click the Add Image button a second time.
Browse to the RISC-V application binary ﬁle, select it, and click Open.
Specify the Flash Address as follows:
File

Address

Bitstream

0x00000000

RISC-V application binary

0x00380000
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Figure 4: Combining a Bitstream and RISC-V Application Binary

10. Click Apply. The software creates the combined .hex ﬁle in the speciﬁed Output
Directory (the default is the project outflow directory).
11. Program the ﬂash with the .hex ﬁle using Programming Mode > SPI Active.
12. Reset the FPGA or power cycle the board.

Copy a User Binary to the Flash Device (2 Terminals)
To boot from a ﬂash device, you need to copy the binary to the device. These instructions
describe how to use two command prompts or terminals to ﬂash the user binary ﬁle.
Note: If you want to store the binary in the same flash device that holds the FPGA bitstream, refer to Copy
a User Binary to Flash (Efinity Programmer) on page 31 instead.

You use two command prompts or terminals:
• The ﬁrst terminal opens an OpenOCD connection to the SoC.
• The second connects to the ﬁrst terminal to write to the ﬂash.
Important: If you are using the OpenOCD debugger in Eclipse, terminate any debug processes before
attempting to flash the memory.

Set Up Terminal 1
1.
2.
3.
4.
5.

Open a Windows command prompt or Linux shell.
Change to SDK_Windows or SDK_Ubuntu.
Execute the setup.bat (Windows) or setup.sh (Linux) script.
Change to the directory that has the cpu0.yaml ﬁle.
Type the following commands to set up the OpenOCD server:
Windows (Trion):
openocd.exe -f bsp\efinix\EfxOpalSoc\openocd\ftdi.cfg
-c "set CPU0_YAML cpu0.yaml"
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-f bsp\efinix\EfxOpalSoc\openocd\flash.cfg

Windows (钛金系列):
openocd.exe -f bsp\efinix\EfxOpalSoc\openocd\ftdi_ti.cfg
-c "set CPU0_YAML cpu0.yaml"
-f bsp\efinix\EfxOpalSoc\openocd\flash_ti.cfg

Linux (Trion):
openocd -f bsp/efinix/EfxOpalSoc/openocd/ftdi.cfg
-c "set CPU0_YAML cpu0.yaml"
-f bsp/efinix/EfxOpalSoc/openocd/flash.cfg

Linux (钛金系列):
openocd -f bsp/efinix/EfxOpalSoc/openocd/ftdi_ti.cfg
-c "set CPU0_YAML cpu0.yaml"
-f bsp/efinix/EfxOpalSoc/openocd/flash_ti.cfg

The OpenOCD server connects and begins listening on port 4444.

Set Up Terminal 2
1.
2.
3.
4.

Open a second command prompt or shell.
Enable telnet if it is not turned on. Turn on telnet (Windows)
Open a telnet local host on port 4444 with the command telnet localhost 4444.
In the OpenOCD shell or command prompt, use the following command to ﬂash the user
binary ﬁle:
flash write_image erase unlock <path>/<filename>.bin 0x380000

Where <path> is the full, absolute path to the .bin ﬁle.
Note: For Windows, use \\ as the directory separators.

Close Terminals
When you ﬁnish:
• Type exit in terminal 2 to close the telnet session.
• Type Ctrl+C in terminal 1 to close the OpenOCD session.
Important: OpenOCD cannot be running in Eclipse when you are using it in a terminal. If you try to run
both at the same time, the application will crash or hang. Always close the terminals when you are done
flashing the binary.

Reset the FPGA
Press the reset button (SW1) on the development board.
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About the Board Specific Package
The board speciﬁc package (BSP) deﬁnes the address map and aligns with the Opal
SoC hardware address map. The BSP ﬁles are located in the bsp/efinix/EfxOpalSoC
subdirectory.
Table 7: BSP Files
File or Directory

Description

app

Files used by the example software and bootloader.

include\soc.mk

Supported instruction set.

include\soc.h

Defines the system frequency and address map.

linker\default.ld

Linker script for the main memory address and size.

linker\bootloader.ld

Linker script for the bootloader address and size.

openocd

OpenOCD configuration files.

Address Map
Note: Because the address range might be updated, 易 灵 思 recommends that you always refer to the
parameter name when referencing an address in firmware, not by the actual address. The parameter
names and address mappings are defined in soc.h.

Table 8: Default Address Map, Interrupt ID, and Cached Channels
Device

Parameter

Size

Interrupt ID

Region

SYSTEM_GPIO_0_IO_APB

4K

[0]: 12

I/O

SYSTEM_I2C_0_IO_APB

4K

8

I/O

SYSTEM_MACHINE_TIMER_APB

4K

31

I/O

SYSTEM_PLIC_APB

4K

–

I/O

SPI master 0

SYSTEM_SPI_0_IO_APB

4K

4

I/O

SPI master 1(3)

SYSTEM_SPI_1_IO_APB

4K

5

I/O

SYSTEM_UART_0_IO_APB

4K

1

I/O

User peripheral

IO_APB_SLAVE_0_APB

64K

–

I/O

On-chip BRAM

SYSTEM_RAM_A_BMB

4 - 512 KB

–

Cache

–

–

25

I/O

GPIO
I2C
Machine timer
PLIC

UART

External interrupt

[1]: 13

Note: The RISC-V GCC compiler does not support user address spaces starting at 0x0000_0000.

(3)

The open-source Opal SoC available on Github has 2 SPI masters. Other variations only have 1.
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Example Software
To help you get started writing software for the Opal, 易灵思 provides a variety of example
software code that performs functions such as communicating through the UART,
controlling GPIO interrupts, performing Dhrystone benchmarking, etc. Each example
includes a makefile and src directory that contains the source code.
Note: Many of these examples display messages on a UART. Refer to the following topics for information
on attaching a UART module and connecting to it in a terminal:
Learn how to attach a UART module.

Learn how to open an Eclipse terminal and connect to the UART module.

Table 9: Example Software Code
Directory

Description

blinkAndEcho

This example blinks an LED and prints a string on the UART
terminal.

bootloader

This software is the bootloader for the system.

common

Provides linking for the makefiles.

dhrystone

This example is a synthetic computing benchmark program.

driver

This directory contains the system drivers for the peripherals
(I2C, UART, SPI, etc.). Refer to API Reference on page 48 for
details.

EfxApb3Example

This example shows how to implement an ABP3 slave.

i2cDemo

This example shows how to connect to an MCP4725 digital-toanalog converter (DAC) using an I2C peripheral.

i2cSlaveDemo

This example illustrates how an I2C slave communicates with
the master.

readFlash

This example shows how to read from a SPI flash device.

spiDemo

This code reads the device ID and JEDEC ID of a SPI flash
device and echoes the characters on a UART.

timerAndGpioInterruptDemo

This example shows how to use use interrupts with a timer and
GPIO.

userInterruptDemo

This example demonstrates user interrupts with UART
messages.

uartInterruptDemo

This exmple shows how to use a UART interrupt.

writeFlash

This example shows how to write to a SPI flash device.

www.elitestek.com

35

Opal RISC-V SoC Hardware and Software User Guide

blinkAndEcho Example
The blink and echo example (blinkAndEcho directory) is a simple example that shows how
to use a register pointer to output data for the GPIO and UART. The design blinks LEDs
blinks LEDs D3 through D8 on the Trion® T20 BGA256 Development Board. When you
type a character, it echoes it on a UART terminal.

dhrystone Example
The Dhrystone example (dhrystone directory) is a classic benchmark for testing CPU
performance. When you run this application, it performs dhrystone benchmark testing and
displays messages and results on a UART terminal.
The following code shows example results:
Dhrystone Benchmark, Version C, Version 2.2
Program compiled without 'register' attribute
Using time(), HZ=12000000
Trying 500 runs through Dhrystone:
Final values of the variables used in the benchmark:
Int_Glob:
5
should be:
5
Bool_Glob:
1
should be:
1
....
Enum_Loc:
1
should be:
1
Str_1_Loc:
DHRYSTONE PROGRAM, 1'ST STRING
should be:
DHRYSTONE PROGRAM, 1'ST STRING
Str_2_Loc:
DHRYSTONE PROGRAM, 2'ND STRING
should be:
DHRYSTONE PROGRAM, 2'ND STRING
Microseconds for one run through Dhrystone: 40
Dhrystones per Second:
24472
User_Time : 245176
Number_Of_Runs : 500
HZ : 12000000
DMIPS per Mhz:
1.16

EfxApb3Example
This simple software design illustrates how to use an APB3 slave peripheral.
The APB3 slave is attached to a pseudorandom number generator. When you run the
application, the Opal SoC programs the APB3 slave to stop generating a new random
number and reads the last random number generated. The test passes if the returned data is a
non-zero value.
APB0 test
Random number: 0xE1ECA84A
Passed!

When you run the application, it blinks LEDs D3 - D8 and D10 alternately with D9 and
displays the message Opal_Soc: Example Design ! on the UART terminal. When
you stop the application the LEDs stop blinking and D9 turns on.

i2cDemo Example
The I2C interrupt example (i2cDemo directory) provides example code for an I2C master
writing data to and reading data from an oﬀ-chip MCP4725 device with interrupt. The
Microchip MCP4725 device is a single channel, 12-bit, voltage output digital-to-analog
converter (DAC) with an I2C interface.
The MCP4725 device is available on breakout boards from vendors such as Adafruit and
SparkFun. You can connect the breakout board's SDA and SCL pins to a development board.
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Trion® T20 BGA256 Development Board:
• SCL—GPIOL_25, which is labeled as 25 on header H4
• SDA—GPIOL_29, which is labeled as 29 on header H4
钛金系列 Ti60 F225 Development Board:
• SCL—GPIOR_25
• SDA—GPIOR_27
The code assumes that the I2C block is the only master on the bus, and it sends frames in
blocks. When you run it, the application connects to the MCP4725 device and increases the
DAC value. It also prints the message Start on a UART terminal.
In this example:
• void trap() traps entries on exceptions and interrupt events
• void externalInterrupt() triggers an interrupt event

i2cSlaveDemo Design
This example illustrates how an I2C slave communicates with the master. It uses a 16-bit
address and 16-bit data register for read and write. The slave is ready to access the master after
the Init Done message displays on the UART.

readFlash Example
The read ﬂash example (readFlash directory) shows how to read data from the SPI ﬂash
device on the development board. The software reads 124K of data starting at address
0x380000, which is the default location of the user binary in the ﬂash device. The application
displays messages on a UART terminal:
Read
Addr
Addr
Addr
...
Addr
Addr
Read

Flash Start
00380000 : =FF
00380001 : =FF
00380002 : =FF
0039EFFE : =FF
0039EFFF : =FF
Flash End

spiDemo Example
The SPI example (spiDemo directory) provides example code for reading the device ID and
JEDEC ID of the SPI ﬂash device on the development board.
• The default base address map of the SPI ﬂash master is 0xF801_4000.
• The default SCK frequency is half of the SoC system clock frequency.
• The default base address of the UART is 0xF801_0000 with a default baud rate of 115200.
The application displays the results on a UART terminal. It continues to print to the
terminal until you suspend or stop the application.
Hello world
Device ID : 17
CMD 0x9F : EF4018
CMD 0x9F : EF4018
...

timerAndGpioInterruptDemo Example
The GPIO interrupt example (timerAndGpioInterruptDemo directory) provides example
code for implementing a rising edge interrupt trigger with a GPIO pin. When an interrupt
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occurs, a UART terminal displays Hello world and then the timer interval. It continues to
print the timer interval until you suspend or stop the application.
Hello world
BSP_MACHINE_TIMER 0
BSP_MACHINE_TIMER 1
...

In this example:
• void trap() traps entries on exceptions and interrupt events
• void externalInterrupt() triggers a GPIO interrupt event

UartInterruptDemo Example
The UartInterruptDemo example shows how to use a UART interrupt to indicate taslk
completion when sending or receiving data over a UART. The UART can trigger a interrupt
when data is available in the UART receiver FIFO or when the UART transmitter FIFO is
empty. In this example, when you type a character in a UART terminal, the data goes to the
UART receiver and ﬁlls up FIFO buﬀer. This action interrupts the processor and forces the
processor to execute an interrupt/priority routine that allows the UART to read from the
buﬀer and send a message back to the terminal.
The application displays messages on a UART terminal:
RX FIFO not empty interrupt
RX FIFO not empty interrupt
RX FIFO not empty interrupt

userInterruptDemo Example
The user interrupt example (userInterruptDemo directory) uses one bit from an APB3 slave
peripheral as an interrupt signal to RISC-V processor. The main routine sets up an interrupt
routine, then triggers an interrupt signal to the user interrupt port by programming bit 2 on
the ABP3 slave to high.
When the RISC-V processor receives the interrupt signal, program execution jumps from the
main routine to the interrupt (or priority) routine. The interrupt routine sets bit 2 low so the
processor can leave the interrupt routine.
The application displays the messages on a UART terminal:
User Interrupt Demo, waiting for user interrupt...
Entered User Interrupt Routine
Turn off Interrupt Signal
Leaving User Interrupt Routine

writeFlash Example
The read ﬂash example (readWrite directory) shows how to write data to the SPI ﬂash device
on the development board. The software writes data starting at address 0x380000, which is
the default location of the user binary in the ﬂash device. The application displays address and
data messages on a UART terminal:
Write Flash Start
WR Addr 00380000 :
WR Addr 00380001 :
WR Addr 00380002 :
...
WR Addr 003800FD :
WR Addr 003800FE :
WR Addr 003800FF :
Write Flash End

=00
=01
=02
=FD
=FE
=FF
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Chapter 10

Using a UART Module
Contents:
•
•
•
•

Using the On-board UART (钛金系列)
Set Up a USB-to-UART Module (Trion)
Open a Terminal
Enable Telnet on Windows

A number of the software examples display messages on a UART terminal. If you are using a
钛金系列 development board, you can simply connect a USB cable to the board and to your
computer. For Trion development boards, you need to use a USB-to-UART converter.

Using the On-board UART (钛金系列)
The 钛金系列 Ti60 F225 Development Board has a USB-to-UART converter connected to
the Ti60's GPIOL_01 and GPIOL_02 pins. To use the UART, simply connect a USB cable
to the FTDI USB connector on the 钛金系列 Ti60 F225 Development Board and to your
computer.
Note: The board has an FTDI chip to bridge communication from the USB connector. FTDI interface 2
communicates with the on-board UART. You do not need to install a driver for this interface because when
you connect the 钛金系列 Ti60 F225 Development Board to your computer, Windows automatically
installs a driver for it.

Finding the COM Port (Windows)
1. Type Device Manager in the Windows search box.
2. Expand Ports (COM & LPT) to ﬁnd out which COM port Windows assigned to the
UART module. You should see 4 devices listed as USB Serial Port (COMn) where n is the
assigned port number. Note the COM number for the third device; that is the UART.

Finding the COM Port (Linux)
In a terminal, type the command:
ls /dev/ttyUSB*

The terminal displays a list of attached devices.
/dev/ttyUSB0 /dev/ttyUSB1 /dev/ttyUSB2 /dev/ttyUSB3

The UART is /dev/ttyUSB2.
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Set Up a USB-to-UART Module (Trion)
The Trion® T20 BGA256 Development Board does not have a USB-to-UART converter,
therefore, you need to use a separate USB-to-UART converter module. A number of modules
are available from various vendors; any USB-to-UART module should work.

Connect to the Trion® T20 BGA256 Development Board
Figure 5: Connect the UART Module to I/O Header H4 (T20 BGA256 Board)
Ground UART
TX
to USB
RX

Module

USB
Connector

26 25 24 23 22 21 20 19 18 16 15 14 13 12 11
27 28 29 30 31 32 33 34 35 36 37 39 40 41 42 43
GND

GPIOL_26
GPIOL_28

H4

1. Connect the UART's RX, TX, and ground pins to the
Trion® T20 BGA256 Development Board using:
• RX—GPIOL_28, which is labeled as 28 on header H4
• TX—GPIOL_26, which is labeled as 26 on header H4
• Ground—Ground, connect to one of the GND pins on header H4
2. Plug the UART module into a USB port on your computer. The driver should install
automatically if needed.

Finding the COM Port (Windows)
1. Type Device Manager in the Windows search box.
2. Expand Ports (COM & LPT) to ﬁnd out which COM port Windows assigned to the
UART module; it is listed as USB Serial Port (COMn) where n is the assigned port
number. Note the COM number.

Finding the COM Port (Linux)
In a terminal, type the command:
dmesg | grep ttyUSB

The terminal displays a series of messages about the attached devices.
usb <number>: <adapter> now attached to ttyUSB<number>

There are many USB-to-UART converter modules on the market. Some use an FTDI chip
which displays a message similar to:
usb 3-3: FTDI USB Serial Device converter now attached to ttyUSB0

However, the Trion® T20 BGA256 Development Board also has an FTDI chip and gives the
same message. So if you have both the UART module and the board attached at the same
time, you may receive three messages similar to:
usb 3-3: FTDI USB Serial Device converter now attached to ttyUSB0
usb 3-2: FTDI USB Serial Device converter now attached to ttyUSB1
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usb 3-2: FTDI USB Serial Device converter now attached to ttyUSB2

In this case the second 2 lines (marked by usb 3-2) are the development board and the ﬁrst
line (usb 3-3) is the UART module.

Open a Terminal
You can use any terminal program, such as Putty, termite, or the built-in Eclipse terminal, to
connect to the UART. These instructions explain how to use the Eclipse terminal; the others
are similar.
1. In Eclipse, choose Window > Show View > Terminal. The Terminal tab opens.

Open a Terminal
Disconnect Terminal Connection

2. Click the Open a Terminal button.
3. In the Launch Terminal dialog box, enter these settings:
Option

Setting

Choose terminal

Serial Terminal

Serial port

COMn (Windows) or ttyUSBn (Linux)

Baud rate

115200

Data size

8

Parity

None

Stop bits

1

Encoding

Default (ISO-8859-1)

where n is the port number for your UART module.

4. Click OK. The terminal opens a connection to the UART.
5. Run your application. Messages are printed in the terminal.
6. When you are ﬁnished using the application, click the Disconnect Terminal Connection
button.

Enable Telnet on Windows
Windows does not have telnet turned on by default. Follow these instructions to enable it:
1. Type telnet in the Windows search box.
2. Click Turn Windows features on or oﬀ (Control panel). The Windows Features dialog
box opens.
3. Scroll down to Telnet Client and click the checkbox.
4. Click OK. Windows enables telnet.
5. Click Close.
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Chapter 11

Using a Soft JTAG Core for Example Designs
Contents:
•
•
•

Enable Soft JTAG Support for the Example Design
Modify the Interface Design
Connect the FTDI Cable

The Eﬁnity® Debugger uses the hard JTAG TAP interface. Out of the box, the Opal SoC
example design also uses the hard JTAG TAP interface for OpenOCD. If you try to use the
same USB connection to the development board for both applications at the same time, they
will conﬂict. To solve this problem, you use a soft JTAG block to handle the OpenOCD
JTAG communication. With this method, you use an FTDI chip cable to connect the board
to your computer (the Eﬁnity® Debugger uses the USB cable).
The simplest way to implement a soft JTAG interface is to use the IP Manager to output an
example design that enables the soft JTAG interface.
Note: 易灵思 recommends you use the C232HM-DDHSL-0 FTDI chip cable rather than a JTAG
mini-module because the software generated by the IP Manager includes the debug configuration file for
the cable.

Enable Soft JTAG Support for the Example
Design
When Enable Soft JTAG TAP is set to True, the example design top-level ﬁle includes the
soft JTAG TAP signals. To enable this option:
1. Open your project.
2. Right-click the SoC module name under IP in the Project pane to open a context-sensitive
menu.
3. Choose Conﬁgure.
4. Choose True for the Enable Soft JTAG TAP option.
5. In the Deliverables tab, enable one or more example designs.
6. Click Generate to generate the SoC with the soft JTAG TAP interface.

Modify the Interface Design
Although you turned on the soft Enable Soft JTAG TAP option, you also need to make
some changes in the Interface Designer:
1. Open the example design project.
2. Open the Interface Designer and make these changes:
a. Remove the JTAG User Tap block.
b. Create these GPIO blocks for the soft JTAG pins:
• io_jtag_tck—Conﬁgure as input; enable Schmitt trigger.
• io_jtag_tdi—Conﬁgure as input.
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• io_jtag_tdo—Conﬁgure as output.
• io_jtag_tms—Conﬁgure as input.
Note: Make sure that the instance names and pin names match the soft JTAG
I/O ports in the top_opalSoc module in the top_opalSoc.v file (top-level
RTL).

c. In the Resource Assigner, assign the soft JTAG ports to the I/O pins you want to use.
Note: When using the C232HM-DDHSL-0 FTDI chip cable, make sure that
the assigned I/O pins use the 3.3V I/O standard and the I/O pin you assign for
io_jtag_tck supports Schmitt Trigger.

d. Check the design to ensure that you have connected everything correctly. The
Interface Designer issues warnings or error messages if it ﬁnds design issues.
e. Save and exit the Interface Designer.
3. Add a Virtual I/O or Logic Analyzer core to your design. For instructions, refer to the
Debugging chaper in the Eﬁnity Software User Guide.
4. Compile the design.
5. Download the resulting bitstream ﬁle to your board using the Eﬁnity® Programmer and a
USB cable connected to the board.
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Connect the FTDI Cable
When you modiﬁed your project to use the soft JTAG block, you assigned GPIO for the 4
JTAG signals, TMS, TDK, TCI, TDO. These GPIO should be assigned to header pins on the
development board so you can connect the C232HM-DDHSL-0 FTDI chip cable to those
pins.
Note: If you have not already done so, install the driver for the FTDI cable as described in Installing USB
Drivers on page 15.

Connecting the FTDI Cable
Connect the cable to your board using the following ﬁgure as a guide.
Figure 6: Connecting the C232HM-DDHSL-0 Cable
USB
Connector

TCK TDI TDO TMS GND Connect to
Ground Pin
Connect to GPIO pins
you assigned in the
Interface Designer.

Debugging in Eclipse
1. Open your Eclipse project.
2. Run or debug the software with the OpenOCD debugger using the default_softTap
launch conﬁguration.
3. Refer to Debug with the OpenOCD Debugger on page 24 for complete instructions.
4. Open the Debugger to perform hardware debugging.
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Chapter 12

Troubleshooting
Contents:
•
•
•
•
•
•
•
•
•

Error 0x80010135: Path too long (Windows)
OpenOCD Error: timed out while waiting for target halted
OpenOCD error code (-1073741515)
OpenOCD Error: no device found
OpenOCD Error: failed to reset FTDI device: LIBUSB_ERROR_IO
OpenOCD Error: target 'fpga_spinal.cpu0' init failed
Eclipse Fails to Launch with Exit Code 13
Efinity Debugger Crashes when using OpenOCD
Undefined Reference to 'cosf'

Error 0x80010135: Path too long (Windows)
When you unzip the SDK on Windows, you may get the error message:
An unuexpected error is keeping you from copying the file. If you continue
to receive this error, you can use the error code to search for help with
this problem.
Error 0x80010135: Path too long

This error occurs if you try to unzip the SDK ﬁles into a deep folder hierarchy instead of one
that is close to the root level. Instead unzip to c:\riscv-sdk.

OpenOCD Error: timed out while waiting for
target halted
The OpenOCD debugger console may display this error when:
• There is a bad contact between the FPGA header pins and the programming cable.
• The FPGA is not conﬁgured with a Opal SoC design.
• You may not have the correct PLL settings to work with the Opal SoC.
• Your computer does not have enough memory to run the program.
To solve this problem:
• Make sure that all of the cables are securly connected to the board and your computer.
• Check the JTAG connection.
• Ensure that the FPGA is programmed with the Opal SoC. Refer to Program the
Development Board on page 17.
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OpenOCD error code (-1073741515)
The OpenOCD debugger may fail with error code -1073741515 if your system does not
have the libusb0.dll installed. To ﬁx this problem, install the DLL. This issue only aﬀects
Windows systems.

OpenOCD Error: no device found
The FTDI driver included with the Opal SoC speciﬁes the FTDI device VID and PID, and
board description. In some cases, an early revision of the 易灵思 development board may
have a diﬀerent name than the one given in the driver ﬁle. If the board name does not
match the name in the driver, OpenOCD will fail with an error similar to the following:
Error: no device found
Error: unable to open ftdi device with vid 0403, pid 6010, description 'Trion T20 Development
Board', serial '*' at bus location '*'

To ﬁx this problem, follow these steps with the development board attached to the computer:
1. Open the Eﬁnity Programmer.
2. Click the Refresh USB Targets button to display the board name in the USB Target
drop-down list.
3. Make note of the board name.
4. In a text editor, open the ftdi.cfg (Trion) or ftdi_ti.cfg (钛金系列) ﬁle in the
/bsp/efinix/EFXOpalSoC/openocd directory.
5. Change the ftdi_device_desc setting to match your board name. For example,
use this code to change the name from Trion T20 Development Board to Trion T20
Developer Board:
interface ftdi
ftdi_device_desc "Trion T20 Developer Board"
#ftdi_device_desc "Trion T20 Development Board"
ftdi_vid_pid 0x0403 0x6010

6. Save the ﬁle.
7. Debug as usual in OpenOCD.

OpenOCD Error: failed to reset FTDI device:
LIBUSB_ERROR_IO
This error is typically caused because you have the wrong Windows USB driver for the
development board. If you have the wrong driver, you will get an error similar to:
Error: failed to reset FTDI device: LIBUSB_ERROR_IO
Error: unable to open ftdi device with vid 0403, pid 6010, description
'Trion T20 Development Board', serial '*' at bus location '*'

Important: 易灵思 recommends using the libusbK driver, which you install using the Zadig software.
Refer to Installing USB Drivers on page 15
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OpenOCD Error: target 'fpga_spinal.cpu0' init
failed
You may receive this error when trying to debug after creating your OpenOCD debug
conﬁguration. The Eclipse Console gives an error message similar to:
Error cpuConfigFile C:RiscVsoc_Jadesoc_jade_swcpu0.yaml not found
Error: target 'fpga_spinal.cpu0' init failed

This error occurs because the path to the cpu0.yaml ﬁle is incorrect, speciﬁcally the slashes
for the directory separators. You should use:
• a single forward slash (/)
• 2 backslashes (\\)
For example, either of the following are good:
C:\\RiscV\\soc_Jade\\soc_jade_sw\\cpu0.yaml
C:/RiscV/soc_Jade/soc_jade_sw/cpu0.yaml

Eclipse Fails to Launch with Exit Code 13
The Eclipse software requires a 64-bit version of the Java JRE. If you use a 32-bit version,
when you try to launch Eclipse you will get an error that Java quit with exit code 13.
If you are downloading the JRE using a web browser from www.java.com, it defaults to
getting the 32-bit version. Instead, go to https://www.java.com/en/download/manual.jsp
to download the 64-bit version.

Efinity® Debugger Crashes when using
OpenOCD
The Eﬁnity® Debugger crashes if you try to use it for debugging while also using OpenOCD.
Both applications use the same USB connection to the development board, and conﬂict if you
use them at the same time. To avoid this issue:
• Do not use the two debuggers at the same time.
• Use an FTDI cable and a soft JTAG core for OpenOCD debugging. See Using a Soft
JTAG Core for Example Designs on page 42 for details.

Undefined Reference to 'cosf'
You may receive an error similar to this when using calculating square root, sine, or cosine
with ﬂoating-point numbers in your application. The Opal SoC does not currently support
ﬂoating point.
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Chapter 13

API Reference
Contents:
•
•
•
•
•
•
•
•
•
•

Control and Status Registers
GPIO API Calls
I2C API Calls
I/O API Calls
Machine Timer API Calls
PLIC API Calls
SPI API Calls
SPI Flash Memory API Calls
UART API Calls
Handling Interrupts

The following sections describe the API for the code in the driver directory.

Control and Status Registers
csr_clear()
Usage

csr_clear(csr, val)

Include

driver/riscv.h

Description

Clear a CSR.

csr_read()
Usage

csr_read(csr)

Include

driver/riscv.h

Description

Read from a CSR.

Example

csrr (t0, mepc) // Write mepc in regfile[t0]

csr_read_clear()
Usage

csr_read_clear(csr, val)

Include

driver/riscv.h

Description

CSR read and clear bit.

csr_read_set()
Usage

csr_read_set(csr, val)

Include

driver/riscv.h

Description

CSR read and set bit.
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csr_set()
Usage

csr_set(csr, val)

Include

driver/riscv.h

Description

CSR set bit.

csr_swap()
Usage

csr_write(csr, val)

Include

driver/riscv.h

Description

Swaps values in the CSR.

csr_write()
Usage

csr_write(csr, val)

Include

driver/riscv.h

Description

Write to a CSR.

Example

csrw (mepc, t0); // Write regfile[t0] in mepc

GPIO API Calls
gpio_getFilteringHit()
Usage

gpio_getFilteringHit(reg)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Read the 32-bit I2C register filter hit with a call back function.

Example

if(gpio_getFilteringHit(I2C_CTRL) == 1)
// Check filter hit value, bit [7] from slave address,
// read =’1’ write =’0’

gpio_getFilteringStatus()
Usage

gpio_getFilteringStatus(reg)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Read the 32-bit I2C register filter hit with a call back function.

Example

if(gpio_getFilteringStatus (I2C_CTRL) == 1)
// Check filter hit status, bit [7] from slave address, read =’1’
write =’0
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gpio_getInput()
Usage

gpio_getInput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Get input from a GPIO.

[IN] value GPIO pin bitwise

gpio_getInterruptFlag()
Usage

gpio_getInterruptFlag(reg)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Read the 32-bit I2C register interrupt flag with a call back function.

Example

Int flag = gpio_getInterruptFlag(I2C_CTRL) & I2C_INTERRUPT_DROP;
// Get Drop interrupt flag from Interrupt register
//[2] I2C_INTERRUPT_TX_DATA
//[3] I2C_INTERRUPT_TX_ACK
//[7] I2C_INTERRUPT_DROP
//[16] I2C_INTERRUPT_CLOCK_GEN_BUSY
//[17] I2C_INTERRUPT_FILTER

gpio_getMasterStatus()
Usage

gpio_getMasterStatus(reg)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Read the 32-bit I2C register master status with a call back function.

Example

int status = gpio_getMasterStatus(I2C_CTRL) & I2C_MASTER_BUSY;
// Get master busy status from status register
[0]I2C_MASTER_BUSY
[4]I2C_MASTER_START
[5]I2C_MASTER_STOP
[6]I2C_MASTER_DROP

gpio_getOutput()
Usage

gpio_getOutput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Read the output pin.

[IN] value GPIO pin bitwise
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gpio_getOutputEnable()
Usage

gpio_getOutputEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Read GPIO output enable.

[IN] value GPIO pin bitwise

gpio_setOutput()
Usage

gpio_setOutput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set GPIO as 1 or 0.

[IN] value GPIO pin bitwise

gpio_setOutputEnable()
Usage

gpio_setOutputEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set GPIO as an output enable.

[IN] value GPIO pin bitwise

gpio_setInterruptRiseEnable()
Usage

gpio_etInterruptRiseEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt on the rising edge of the GPIO.

[IN] value GPIO pin bitwise

gpio_setInterruptFallEnable()
Usage

gpio_setInterruptFallEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt on the falling edge of the GPIO.

[IN] value GPIO pin bitwise

gpio_setInterruptHighEnable()
Usage

gpio_setInterruptHighEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt when the GPIO is high.

[IN] value GPIO pin bitwise
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gpio_setInterruptLowEnable()
Usage

gpio_setInterruptLowEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt when the GPIO is low.

[IN] value GPIO pin bitwise

I2C API Calls
i2c_applyConfig()
Usage

void i2c_applyConfig(u32 reg, I2c_Config *config)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Apply I2C configuration to register or for initial configuration.

[IN] config struct of I2C configuration

i2c_clearInterruptFlag()
Usage

void i2c_clearInterruptFlag(u32 reg, u32 value)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Clear the I2C interrupt flag.

[IN] value I2C interrupt register

i2c_disableInterrupt()
Usage

void i2c_disableInterrupt(u32 reg, u32 value)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Disable I2C interrupt.

Example

[IN] value I2C interrupt register:
• [2] I2C_INTERRUPT_TX_DATA
• [3] I2C_INTERRUPT_TX_ACK
• [7] I2C_INTERRUPT_DROP
• [16] I2C_INTERRUPT_CLOCK_GEN_BUSY
• [17] I2C_INTERRUPT_FILTER

i2c_disableInterrupt(I2C_CTRL, I2C_INTERRUPT_TX_ACK);
// Enable I2C interrupt with interrupt TX Ack
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i2c_enableInterrupt()
Usage
Parameters

void i2c_enableInterrupt(u32 reg, u32 value)
[IN] reg struct of I2C setting value
[IN] value I2C interrupt register:
•
•
•
•
•

[2] I2C_INTERRUPT_TX_DATA
[3] I2C_INTERRUPT_TX_ACK
[7] I2C_INTERRUPT_DROP
[16] I2C_INTERRUPT_CLOCK_GEN_BUSY
[17] I2C_INTERRUPT_FILTER

Include

driver/i2c.h

Description

Enable I2C interrupt.

Example

i2c_enableInterrupt(I2C_CTRL, I2C_INTERRUPT_FILTER |
I2C_INTERRUPT_DROP);
// Enable I2C interrupt with interrupt filter and drop

i2c_filterEnable()
Usage
Parameters

void i2c_filterEnable(u32 reg, u32 filterId, u32 config)
[IN] reg struct of I2C setting value

[IN] filterID filter configuration ID number
[IN] config struct of I2C configuration

Include

driver/i2c.h

Description

Enable the filter configuration.

i2c_listenAck()
Usage

void i2c_listenAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Listen acknowledge from the slave.

i2c_masterBusy()
Usage

void i2c_masterBusy(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Get the I2C busy status.

i2c_masterStatus()
Usage

int i2c_masterStatus(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Get the I2C status.
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i2c_masterDrop()
Usage

void i2c_masterDrop(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the drop state.

Example

i2c_masterDrop(I2C_CTRL);

i2c_masterStart()
Usage

void i2c_masterStart(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the start status.

i2c_masterStartBlocking()
Usage

void i2c_masterStartBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Asserts a start condition.

i2c_masterStop()
Usage

void i2c_masterStop(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the stop status.

i2c_masterStopBlocking()
Usage

void i2c_masterStartBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Asserts a stop condition.

i2c_masterStopWait()
Usage

void i2c_masterStopWait(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

The stop condition is wait busy..
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i2c_setFilterConfig()
Usage
Parameters

void i2c_setFilterConfig(u32 reg, u32 filterId, u32 config)
[IN] reg struct of I2C setting value

[IN] filterID filter configuration ID number
[IN] config struct of I2C configuration:
• [9:0] I2C slave address
• [14] I2C_FILTER_10BITS
• [15] I2C_FILTER_ENABLE

Include

driver/i2c.h

Description

Set the filter configuration.

Example

i2c_setFilterConfig(I2C_CTRL, 0, 0x30 | I2C_FILTER_ENABLE);
// Enable filter with ID=0 slave addr = 0x30 default 7 bit filter

i2c_txAck()
Usage

void i2c_txAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transmit acknowledge.

i2c_txAckBlocking()
Usage

void i2c_txAckBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Assert an ACK on the SDA pin.

i2c_txAckWait()
Usage

void i2c_txAckWait(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Wait for an acknowledge to transmit.

i2c_txByte()
Usage

void i2c_txByte(u32 reg, u8 byte)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transfers one byte to the I2C slave.

[IN] byte 8 bits data to send out
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i2c_txByteRepeat()
Usage

void i2c_txByteRepeat(u32 reg, u8 byte)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Send a byte and then wait until it is fully transmited on the I2C bus.

[IN] byte 8 bits data to send out

i2c_txNack()
Usage

void i2c_txNack(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transfers a NACK.

i2c_txNackRepeat()
Usage

void i2c_txNackRepeat(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Send a NACK and then wait until it is fully transmited on the I2C bus.

i2c_txNackBlocking()
Usage

void i2c_ txNackBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Assert a NACK on the SDA pin.

i2c_rxAck()
Usage

int i2c_rxAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Returns

[OUT] 1 bit acknowledge

Include

driver/i2c.h

Description

Receive an acknowledge from the I2C slave.

i2c_rxData()
Usage
Parameters

unit32_t i2c_rxData(u32 reg)
[IN] reg struct of I2C register

Returns

[OUT] 1 byte data from I2C slave

Include

driver/i2c.h

Description

Receive one byte data from I2C slave.
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i2c_rxNack()
Usage

int i2c_rxNack(u32 reg)

Parameters

[IN] reg struct of I2C register

Returns

[OUT] 1 bit no acknowledge

Include

driver/i2c.h

Description

Receive no acknowledge from the I2C slave.

I/O API Calls
read_u8()
Usage

u8 read_u8(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 8 bits.

read_u16()
Usage

u16 read_u16(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 16 bits.

read_u32()
Usage

u32 read_u32(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 32 bits.

write_u8()
Usage

void write_u8(u8 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 8 bits unsigned data to the specified address.
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write_u16()
Usage

void write_u16(u16 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 16 bits unsigned data to the specified address.

write_u32()
Usage

void write_u32(u32 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 32 bits unsigned data to the specified address.

write_u32_ad()
Usage

void write_u32_ad(u32 address, u32 data)

Include

driver/io.h

Parameters

[IN] address SoC address
[IN] data SoC address data

Description

Write 32 bits unsigned data to the specified address.

Machine Timer API Calls
machineTimer_setCmp()
Usage

void machineTimer_setCmp(u32 p, u64 cmp)

Include

driver/machineTimer.h

Parameters

[IN] p machine timer interrupt

Description

Set a timer value to trigger an interrupt.

[IN] cmp machine timer compare register

machineTimer_getTime()
Usage

u64 machineTimer_getTime(u32 p)

Include

driver/io.h

Parameters

[IN] p machine timer interrupt

Returns

[OUT] timer value

Description

Gets the timer value.
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machineTimer_uDelay()
Usage

u64 machineTimer_uDelay(u32 usec, u32 hz, u32 reg)

Include

driver/io.h

Parameters

[IN] usec microseconds
[IN] hz core frequency

[IN] reg machine timer interrupt
Description

Use the machine timer to make a delay.

PLIC API Calls
plic_set_priority()
Usage

void plic_set_priority(u32 plic, u32 gateway, u32 priority)

Include

driver/plic.h

Parameters

[IN] plic PLIC register structure
[IN] gateway interrupt type

[IN] priority interrupt priority
Description

Set the interrupt priority.

plic_set_enable()
Usage

void plic_set_enable(u32 plic, u32 target, u32 gateway, u32
enable)

Include

driver/plic.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] gateway interrupt type
[IN] enable
Description

Set the interrupt enable.

plic_set_threshold()
Usage

void plic_set_threshold(u32 plic, u32 target, u32 threshold)

Include

driver/plic.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] threshold enable = 1
Description

Masks individual interrupt sources for the HART.
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plic_claim()
Usage

u32 plic_claim(u32 plic, u32 target)

Include

driver/plic.h

Parameters

[IN] plic PLIC register structure

Description

Claim the PLIC interrupt

[IN] target HART number

plic_release()
Usage

void plic_release(u32 plic, u32 target, u32 gateway)

Include

driver/plic.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] gateway interrupt type
Description

Release the PLIC interrupt.

SPI API Calls
spi_applyConfig()
Usage

void spi_applyConfig(Spi_Reg *reg, Spi_Config *config)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Applies the SPI configuration to to a register for initial configuration.

[IN] config struct of the SPI configuration

spi_cmdAvailability()
Usage

spi_cmdAvailability(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Read the SPI command buffer.

spi_diselect()
Usage

void spi_select(Spi_Reg *reg, uint32_t slaveId)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

De-asserts the SPI select (SS) pin.

[IN] slaveId ID for the slave
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spi_read()
Usage

uint8_t spi_write(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Returns

[OUT] reg One byte of data

Description

Receives one byte from the SPI slave.

spi_rspOccupancy()
Usage

spi_rspOccupancy(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Read the occupancy buffer.

spi_select()
Usage

void spi_select(Spi_Reg *reg, uint32_t slaveId)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Asserts the SPI select (SS) pin.

[IN] slaveId ID for the slave

spi_write()
Usage

void spi_write(Spi_Reg *reg, uint8_t data)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Transfers one byte to the SPI slave.

[IN] data 8 bits of data to send out

SPI Flash Memory API Calls
spiFlash_f2m_()
Usage

void spiFlash_f2m_(Spi_Reg * spi, u32 flashAddress, u32
memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] flashAddress flash device address
[IN] memoryAddress memory address
[IN] size programming address size

Description

Copy data from the flash device to memory.
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spiFlash_f2m()
Usage

void spiFlash_f2m(Spi_Reg * spi, u32 cs, u32 flashAddress, u32
memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register
[IN] cs chip select

[IN] flashAddress flash device address
[IN] memoryAddress memory address
Description

Copy data from the flash device to memory with chip select control.

spiFlash_f2m_withGpioCs()
Usage

void spiFlash_f2m_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio, u32
cs, u32 flashAddress, u32 memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

[IN] flashAddress flash device address
[IN] memoryAddress memory address
[IN] size programming address size
Description

Flash device from the SPI master with GPIO chip select.

spiFlash_diselect()
Usage

void spiFlash_diselect(Spi_Reg *spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

De-asserts the SPI flash device from the master chip select.

[IN] cs chip select

spiFlash_diselect_withGpioCs()
Usage

void spiFlash_diselect_withGpioCs(Gpio_Reg *gpio, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] gpio reg struct of the GPIO register

Description

De-asserts the SPI flash device from the master with the GPIO chip select.

[IN] cs chip select

spiFlash_init_()
Usage

void spiFlash_init_(Spi_Reg * spi)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Initialize the SPI reg struct.
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spiFlash_init()
Usage

void spiFlash_init(Spi_Reg * spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Initialize the SPI reg struct with chip select de-asserted.

[IN] cs chip select

spiFlash_init_withGpioCs()
Usage

void spiFlash_init_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio,
u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

Description

Initialize the SPI reg struct with GPIO chip select de-asserted.

spiFlash_select()
Usage

void spiFlash_select(Spi_Reg *spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Select the SPI flash device.

[IN] cs chip select

spiFlash_select_withGpioCs()
Usage

spiFlash_select_withGpioCs(Gpio_Reg *gpio, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] gpio reg struct of the GPIO register

Description

Select the SPI flash device with the GPIO chip select.

[IN] cs chip select

spiFlash_wake_()
Usage

void spiFlash_wake_(Spi_Reg * spi)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Release power down from the SPI master.
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spiFlash_wake()
Usage

void spiFlash_wake(Spi_Reg * spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Release power down from the SPI master with chip select.

[IN] cs chip select

spiFlash_wake_withGpioCs()
Usage

void spiFlash_wake_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio,
u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

Description

Release power down from the SPI master with the GPIO chip select.

UART API Calls
uart_applyConfig()
Usage

char uart_applyConfig(Uart_Reg *reg, Uart_Config *config)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Applies the UART configuration to to a register for initial configuration.

[IN] config struct of the UART configuration

uart_emptyInterruptEna()
Usage

uart_emptyInterruptEna(u32 reg char ena)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Enable the TX FIFO empty interrupt.

[IN] ena Enable interrupt

uart_NotemptyInterruptEna()
Usage

uart_NotemptyInterruptEna(u32 reg char ena)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Enable the RX FIFO not empty interrupt.

[IN] ena Enable interrupt
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uart_read()
Usage

char uart_read(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Returns

[OUT] reg character that is read

Description

Reads a character from the UART slave.

uart_readOccupancy()
Usage

uint32_t uart_readOccupancy(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Read the number of bytes in the RX FIFO.

uart_status_read()
Usage

uart_status_read(u32 reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Returns

[OUT] 32-bit status register from the UART

Description

Read the UART status.

uart_status_write()
Usage

uart_status_write(u32 reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Returns

[OUT] 32-bit status register from the UART

Description

Write the UART status.

[IN] data input data for the UART status.

uart_write()
Usage

void uart_write(Uart_Reg *reg, char data)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Write a character to the UART.

[IN] data write a character
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uart_writeStr()
Usage

void uart_writeStr(Uart_Reg *reg, char* str)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Write a string to the UART TX.

[IN] str string to write

uart_writeAvailability()
Usage

uart_writeAvailability(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

UART read/write FIFO.
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Handling Interrupts
There are two kinds of interrupts, trap vectors and PLIC interrupts, and you handle them
using diﬀerent methods.
Figure 7: Types of Interrupts
Exceptions
mcause
Register

Machine Timer
Machine External Interrupt

Trap
Vector

Trap
Machine Trap
RISC-V
Cause (mcause)
SoC

I2C Interrupt
SPI Interrupt
Interrupt ID

UART Interrupt

Interrupt Claim Registers
PLIC

External Interrupt
Other Interrupt

Trap Vectors
Trap vectors trap interrupts or exceptions from the system. Read the Machine Cause Register
(mcause) to identify which type of interrupt or exception fthe system is generating. Refer
to "Machine Cause Register (mcause): 0x342" in the data sheet for your SoC for a list of the
exceptions and interrupts used for trap vectors. The following ﬂow chart explains how to
handle trap vectors.
For CAUSE_MACHINE_EXTERNAL, it will call the subroutine to process the PLIC level
interrupts.
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Figure 8: Handling Trap Vectors
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PLIC Interrupts
The PLIC collects external interrupts and is also used for
CAUSE_MACHINE_EXTERNAL cases. Read the interrupt claim registers (PLIC claim) to
identify the source of the external interrupt. Refer to Address Map on page 34 for a list of
the interrupt IDs.
The following ﬂow chart shows how the PLIC handles interrupts.The PLIC identiﬁes the
interrupt ID and processes the corresponding interrupts.
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Figure 9: Handling PLIC Interrupts
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Revision History
Table 10: Revision History
Date

Version

December 2021

2.4

Description
Updated the version numbers for SDK tools.

Updated the options for configuring the SoC operating frequency and onchip RAM in the IP Configuration wizard.
The simulation instructions now use run.py.

Explained new Efinity Programmer feature for programming a flash device
with a combined user bitstream and application binary.
For the PLIC API calls, include the plic.h file (not io.h).
September 2021

2.3

The SoC Operating Frequency (Hz) minimum frequency changed to
20000000 Hz. (DOC-544)

July 2021

2.2

Added link to OpenJDK (DOC-457)

Added information about the flow for handling interrupts in the API
Reference chapter. (DOC-398)
Updated the GPIO, I2C, and UART API calls. (DOC-454)

Added additional instructions on using the Efinity and OpenOCD
debuggers at the same time. (DOC-426)
Added descriptions for the dmasg and i2cSlaveDemo examples.
Updated to support the Ti60 Development Board.
February 2021

2.1

Corrected description for APB3 example design.

December 2020

2.0

Updated to describe new configuration and deliverables via IP Manager in
Efinity® v2020.2.

November 2020

1.2

Added uartInterruptDemo example.

August 2020

1.1

Updated for v1.1 of the SDK; the process for setting up Eclipse
environment variables and debug configurations is streamlined.
Added chapter on simulation.

User peripheral address size changed to 64K.

io_apbSlave_PADDR size changed to 15:0.
Added FTDI Dual RS232 HS mini module in steps to install the USB driver.
Updated instructions for installing USB drivers on Linux.
June 2020

1.0

Initial release.
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